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Enhancements, New Functionality, and Fixed 
Problems
Release 5000.0.0 contains major changes and new functionality. The primary new functionality for 
the Classic applications is the incorporation of the new Seismic Data Management functionality in 
OpenWorks. It offers a high value to the management of seismic data in the end application. 

This section includes enhancements for many of the Release 5000.0.0 products that will be 
released throughout 2008. It also contains new functionality and fixed problems for the products. 

Because OpenWorks enhancements are among the most far-reaching, they are listed first. After 
OpenWorks, the products are grouped according to business lines and listed alphabetically within 
the groupings. More details of new functionality can be found in the New Features manuals or 
Release Notes for each point product.

For information on other products, click on these hyperlinks:

OpenWorks Release 5000.0.0 on page 49

Drilling and Completions on page 55

Geological and Geophysical Technologies on page 63

Information Management and Infrastructure on page 70

Reservoir Management on page 74

OpenWorks Release 5000.0.0

Seismic Data Management in OpenWorks

• Integration. Seismic data is more tightly integrated in the OpenWorks 5000.0.0 database. 
Some seismic data is catalogued and referenced in the OpenWorks database. Other seismic 
data is stored in the OpenWorks database.

— Catalogued: seismic data sets, 3D horizons, and prestack and poststack seismic data

— Stored: 2D horizons, misties, static shifts, horizon lists, and fault lists

• The Seismic Data Manager in OpenWorks 5000.0.0 allows you to:

— Manage the data it previously did: 2D and 3D surveys.

— Manage the seismic data listed above, which SeisWorks utilities managed in previous 
releases.
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• Seismic Project Manager Eliminated. With the change in project structure in OpenWorks, 
and because seismic data has been integrated into the OpenWorks database, the Seismic 
Project Manager no longer exists in Release 5000.0.0. Project Administration in OpenWorks 
now performs all project management.

• Project Data Transfer (PDT). To support the new data stored in the OpenWorks database, 
Project Data Transfer (PDT) has also been enhanced to support the transfer of 2D horizons, 
misties, and static shifts.

New Interpretation Project Optimizes Project Administration

Project administration has been simplified and optimized in OpenWorks 5000.0.0. A project can 
now be a view or subset of another project, and the master and working projects in SeisWorks 
have been integrated into the new OpenWorks project structure.

• Views of an OpenWorks Project

Projects have been renamed project databases. Each project database contains one or more 
interpretation projects. The interpretation projects are subsets or views of the data in the project 
database. Each interpretation project can have its own Cartographic Reference System (CRS) 
and lists of lines, surveys, and wells. With this new design, one copy of the data can have separate 
views, lessening the demands on computing resources and project and data administration. If 
data updates are needed, only the project database needs to be updated. Each interpretation 
project can be configured to automatically refresh the data in its view.

• SeisWorks Projects Replaced by OpenWorks Projects

OpenWorks projects are restored into the database, and the data from the SeisWorks projects are 
restored to the location where seismic data is to be stored in the environment. When the 
OpenWorks project is upgraded to Release 5000.0.0 in Project Administration, the SeisWorks 
project information is integrated into the OpenWorks project database. Each of the working 
projects from SeisWorks can become an interpretation project of the project database, depending 
on the configurations chosen by the person upgrading the restored OpenWorks project.

Projects and Districts

• The Ability to Separate Data. OpenWorks and its database now directly support districts. 
Districts allow a company to separate OpenWorks projects and seismic data into more 
manageable and secure groups. They become especially useful when a company may have 
large numbers of projects and when a company wants to separate data by business unit for 
better data security or storage ownership.

• Implementing Districts. In an installation of OpenWorks, a company can decide whether it 
will implement districts or not. To implement districts, dir.dat and owdir.dat must be configured 
for each district, and a new file, district.dat, must be configured with the name of each district 
and the directory of each district’s dir.dat and owdir.dat. Utilities, such as Project 
Administration and Project Status Tool, support districts in their interfaces. For example, when 
a user of OpenWorks creates a new project in Project Administration, part of the project 
configuration includes selecting the district to which it will belong.



Landmark Release Notes

5000.0.0 Release Notes Page 51 of 84 December 2007

Data Model Enhancements and Removed Tables

The data model in Release 5000.0.0 contains enhancements and removes unused parts of the 
OpenWorks data model.

• Enhancements

— Storage for seismic data (2D horizons, misties, static shifts, horizon lists, and fault lists)

— References to seismic data stored in flat files (seismic data sets, 3D horizons, and 
prestack and poststack seismic data)

— Each Well Master table now has a Well Location table assigned to it. This table allows 
well data to be more easily transferred between an OpenWorks database and the Well/
Wellbore model of an EDM database.

— Storage for processing history

— Simplification of the fault plane trimesh model

— Storage for offset synthetics and vertical seismic profiles (VSPs) for Well Seismic Fusion

— Some validation (VC) tables have been converted to reference tables (R), and each refer-
ence table now has timestamp and source fields.

— Storage for interpretation notes

— Storage for interpretation sets

— Storage for 3D earth model frameworks

— Remarks attributes increased to 200 characters

— ID’s generated with sequences not OW_UID_VALUES

— Data Dictionary (support for Reference Data Manager)

— Storage of additional list tables (grid lists, fault lists, and horizon lists)

— Support for automatic position log computation when adding directional surveys

— Support for automatic handling of tie points

— Simplification of the data model for Depth Team Express

• Removed Tables

— PDEN production data model: The PDEN tables have been replaced with the PDM 
tables.

— ARIES Reserves Management

— VIP simulation grids

— Gocad model BLOBs

— OpenExplorer tables

— OpenWorks culture model: These tables were replaced by ZGF files in OpenWorks 
R2003.
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Development Kit Enhancements

The Development Kit for OpenWorks 5000.0.0 has been updated to:

• include functions to access the data in new tables of the OpenWorks data model.

• include functions to support data change messaging provided by Oracle’s Streams Advanced 
Queuing.

• remove functions related to tables that have been removed.

The Development Kit is built with Microsoft’s Visual Studio 8. For detailed information about 
changes in the Development Kit for OpenWorks, see the documentation included in the 
Development Kit. The Development Kit for OpenWorks is available separately from OpenWorks. 
Consult your Customer Support Representative for more information about acquiring the 
Development Kit.

Redesigned Data Management Utilities

OpenWorks 5000.0.0 includes several redesigned project management utilities and data 
managers.

• Project Utilities: Project Administration and Project Status Tool

• Data Managers: Data Domain Manager (now allows editing of the data dictionary as well as 
reference data), Curve Dictionary, Map Data Manager, Seismic Data Manager, and Well Data 
Manager

These new utilities and managers have the following benefits:

— Cross-platform Java applications, which do not require X Window System or Motif sup-
port in any operating system.

— Enhanced integration with more Landmark applications, because they are based on com-
ponents from Landmark’s DecisionSpace products.

— Powerful table functions that allow users to search, sort, view, and manipulate the data 
displaying in a project utility or data manager.

Private Interpretation IDs

Interpretation ID Manager replaces the Interpreters utility. The manager allows you to create 
interpretation IDs that are comparable to the names you would have created in the Interpreters 
utility, plus more. 

• New Tables for Searching, Editing, And More. The interpretation IDs, along with their 
associated data, are presented in a table that allow you to sort, filter, and search the table; 
change the appearance of the table to make some data more prominent; and export rows of 
data to a file.
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• Editing IDs. You can edit an ID in the table or in a form view.

• More Room for Remarks. The Description field in the Interpreters utility has become a Long 
Remark field that allows remarks of indefinite length.

Interpretation IDs can be public or private. Public IDs are similar to the names created in the 
Interpreters utility and are accessible by any user of the OpenWorks database. Private IDs allow 
you to create an ID limited to only certain users. Each user added to a private ID has one of three 
security levels: owner, manager, or interpreter. An asset team can manage one or more private 
IDs to fit the purposes of the team.

Support for Oracle Streams Advanced Queuing (AQ) for Data Change Messaging

OpenWorks now uses Pointing Dispatcher (PD) just for communications between its client 
applications. Oracle’s Streams Advanced Queuing (AQ) now conducts data change messaging 
with the OpenWorks database.

Advanced Queuing has several advantages:

• Communication. Changes to the data in an OpenWorks project are reliably communicated to 
any application accessing the project across a network.

• Monitoring Updates. AQ allows Landmark applications accessing the OpenWorks database 
to more easily and efficiently monitor data updates from multiple workstations on a network in 
real-time.

• Configuration. Previously, PD sometimes required special configurations and environment 
variables for some applications to be able to receive notifications about data changes. With 
AQ, those configurations are unnecessary. If the application can communicate with the 
OpenWorks database, the application can receive data change notifications.

• Faster Communication. AQ messages can indicate the boundaries of a transaction with the 
database. The applications accessing the OpenWorks database can then commit a set of 
change messages at the end of the transaction instead of at each individual change. This 
capability speeds up communication with the database.

OpenWorks Users are Now Internally Authenticated Users

OpenWorks now uses the Oracle Secure Enterprise Password Store (Oracle Wallet) to store 
passwords to the database and to handle the security of the passwords.

When a new user is added to the OpenWorks database, the user is associated with the user’s 
name in the operating system. When the OpenWorks user first starts an OpenWorks application, 
the user must provide a password to the OpenWorks database. The user name in the operating 
system and the database must be the same, but the passwords can be different.

When a user accesses an OpenWorks database with a web-based application, the application 
prompts the user for a user name and password. Then, access to the data is allowed.
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Data Model Rationalization Between OpenWorks and Engineering Data Model 
(EDM)

OpenWorks now includes a table for well locations. Each wellbore (Well Master table) is 
associated with a Well Location table that relates to the well/wellbore data model in EDM. The new 
well data model in OpenWorks allows well data to be more easily transferred between Open 
Works and EDM.

Other Changes

• Processing History. OpenWorks now captures the data types of the input and output data 
and captures the parameters that transform the data from input data to output data. 
Specifically, the processing history retains interpretation knowledge and the context of the 
data. It allows you to revise interpretations with new data, and makes cleaning and archiving 
projects easier. It allows one team to easily hand off a project to another team, and can 
minimize productivity loss when the composition of an asset team changes.

• Application Preferences. In the rewritten utilities and managers, a user can save 
preferences. Besides user preferences, each application has default preferences, and some 
preferences can be set for the entire OpenWorks site.

• New Error Logging Console. In the rewritten utilities and managers, a Tools menu allows 
you to display the Error Logging Console. The Error Logging Console allows you to view errors 
as they occur without resorting to a terminal window, and to dynamically set the error reporting 
level for the console window and the error log file separately.

• Updated Geographic Component. Release 5000.0.0 includes components from GeoCalc 
6.3 (from Blue Marble Geographics) for coordinate transformations.
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Drilling and Completions

Engineer’s Desktop (Entire Suite of Products)

• Platforms and Databases. The Engineer’s Desktop suite of applications is now available on 
Windows Vista Enterprise for the 5000.0.0 release. Supported databases for 5000.0.0 are 
Oracle 10g, Microsoft SQL Server 2005, and Microsoft SQL Server 2005 Express.

AFE Management System to EDT Link

• Platform. AFE Management System to AFE Link is an application on Engineer’s Desktop 
5000.0.0. For this release, AFE Management System to AFE Link is available on Windows 
Vista Enterprise.

CasingSeat

• Platform. CasingSeat is an application on Engineer’s Desktop 5000.0.0. For this release, 
CasingSeat is available on Windows Vista Enterprise.

• New Default Tabs. Tabs are saved at the Design level. In the past, tab layout was saved by 
individual users. Now when a Design is saved, the tab layout and content are saved as the 
default view setting for the Design. The new tab settings become the view for all other users 
who open the Design.

• Internationalization. CasingSeat is now designed to support regional settings in Windows.

• Well Explorer Virtual Folders Added to the Well Explorer Tree. These folders allow users 
to organize data items (such as Projects, Wells, Designs, etc.) in a customizable hierarchy that 
can be up to three levels deep.

• OpenWire 2003.0.8. It can be launched directly from the Well Explorer with a right-click menu 
command at the Database level.

• Formations Added to the Associated Data Viewer. They allow formations to be copied 
between Designs.

• New Assemblies Added to the Associated Data Viewer. They have copy/paste 
functionality: Casing. Not valid for Actual Designs.

• Catalogs Added for Well Completion Components. Support for these catalogs was added 
to OpenWells, PROFILE, WELLPLAN, and Catalog Editor.

COMPASS

• Platform. COMPASS is an application on Engineer’s Desktop 5000.0.0. For this release, 
COMPASS is available on Windows Vista Enterprise.

• Targets. They can now be assigned to additional hierarchical data levels, including Project, 
Site, Well, Wellbore, and Design.
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• Printing. It is now possible to print, or use print preview, from the Survey and Plan Editors.

• Column Order on the Survey and Plan Editors. It can now be changed.

• Well Explorer Virtual Folders Added to the Well Explorer Tree. These folders allow users 
to organize data items (such as Projects, Wells, Designs, etc.) in a customizable hierarchy that 
can be up to three levels deep.

• Integrated WITSML v. 1.2 Support. It allows the creation of OpenWire 2003.0.8 pipelines 
from the Well Explorer tree to load data into the EDM database directly from a remote WITSML 
server.

• OpenWire 2003.0.8. It can be launched directly from the Well Explorer with a right-click menu 
command at the Database level.

Data Analyzer

• Platform. Data Analyzer is an application on Engineer’s Desktop 5000.0.0. For this release, 
Data Analyzer is available on Windows Vista Enterprise.

• Metadata Update. The Selection Tree metadata used for both Data Analyzer and the Data 
Validation feature within OpenWells (including EDM Administration Rule Book Editor) has 
been updated to reflect data model changes and additions that are new for this release. This 
includes being able to query data in the new Completions Catalogues, Multi-Wellbore Well 
Planning, and Oilfield Waste Management extensions to OpenWells.

• Fixed Defects. The following significant defects for Data Analyzer were corrected:

— Defect #728645: Catalog Editor tree should be in sort order.

— Defect #730022: Fluids (CD_Fluid) View should not be linked in when reporting on Stimu-
lation Views.

— Defect #735916: Graph Wizard Step 3 Dialog Name is incorrect.

OpenWells 

• Platforms. OpenWells is an application on Engineer’s Desktop 5000.0.0. For this release, 
OpenWells is available on Windows Vista Enterprise.

• Planning of Multilateral Wells. The Well Planning input form was enhanced to enable 
planning of multilateral wells, so that multiple wellbores and designs are now supported.

• Completions Catalogs. Enhancements were added.
• Well Explorer Virtual Folders Added to the Well Explorer Tree. These folders allow users 

to organize data items (such as Projects, Wells, Designs, etc.) in a customizable hierarchy that 
can be up to three levels deep.

• Catalogs Added for Well Completion Components. Support for these catalogs was added 
to OpenWells, PROFILE, WELLPLAN, and Catalog Editor.
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PROFILE

• Platform. PROFILE is an application on Engineer’s Desktop 5000.0.0. For this release, 
PROFILE is available on Windows Vista Enterprise.

• Extended Planning and Reporting. The primary focus for this release of PROFILE has 
been to extend planning and reporting for Completions and Multi-Laterals (OpenWells) 
through new Completions equipment catalog selection architecture and associated comple-
tions-related enhancements. The goal is to enable completions and well services teams to 
better document and manage completions from planning to installation and management 
through to abandonment. In addition to the catalog selection architecture, assembly and com-
ponent description interfaces are extended so that additional information and supporting doc-
umentation can be saved with the data. In addition, PROFILE is now extended to support 
description and visualization of equipment attached to Casing and Completion assemblies.

• Completion Catalogs Selection. This feature is now enabled in the Well Designer Wellbore 
Equipment and Wellheads tabs. In the Wellheads tab, Completion Catalogs are grouped by 
wellhead components and hangers in accordance with Catalog Editor organization.

• New Equipment Section Types. To support better segregation of different types of comple-
tion tools, a number of new equipment section types with supporting component type lists 
have been added to the Landmark standard list of equipment for this release.

• Well Explorer Virtual Folders Added to the Well Explorer Tree. These folders allow users 
to organize data items (such as Projects, Wells, Designs, etc.) in a customizable hierarchy that 
can be up to three levels deep.

• Catalogs. They were added for Well Completion components. Support for the catalogs was 
added to OpenWells, PROFILE, WELLPLAN, and Catalog Editor.

Real-Time View

• Platform. Real-Time View is an application on Engineer’s Desktop 5000.0.0. For this release, 
Real-Time View is available on Windows Vista Enterprise.

• Key New Features. This release of Real-Time View sees the introduction of a number of key 
new features that enable operators to manage more effectively both time-based and depth-
based log data within their Engineer’s Desktop environment. These improvements include:

— Depth-based log storage and visualization. Real-Time View has been extended to 
also support depth-based logs. A new LAS import feature is available for Depth-based 
logs so that log files available in that format can be imported, stored in EDM, and visual-
ized within Real-Time View.

— Log and Curve Header Editor. For active logs, a new Log Header Editor feature is avail-
able from the Tools menu (Tools > Edit Log Header…). This feature enables engineers 
to review and edit Log and Curve Header information inaccessible in previous versions of 
Real-Time View.

— Internationalization. Real-Time View has been extended to enable the user interface 
text to be translated into other languages.
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— WELLPLAN Integration. You can now use Real-Time View Template Viewer to display 
Depth-based drilling data logs within WELLPLAN. This feature allows real-time data 
imported into EDM via OpenWire to be displayed inside WELLPLAN for a particular 
Design/Case. The capability provides the engineer with a valuable reference when com-
paring predicted actual loads against those actually measured during well construction.

— Well Explorer Virtual Folders Added to the Well Explorer Tree. These folders let you 
organize data items (such as Projects, Wells, Designs, etc.) in a customizable hierarchy 
that can be up to three levels deep.

StressCheck

• Platform. StressCheck is an application on Engineer’s Desktop 5000.0.0. For this release, 
StressCheck is available on Windows Vista Enterprise.

• Tab Layout. Default tabs were added. (Tabs are saved at the Design level.) In the past, tab 
layout was saved by individual users. Now, when a Design is saved, the tab layout and con-
tent are saved as the default view setting for the Design. The new tab settings become the 
view for all other users who open the Design.

• Viewing of Classic Well Schematic. You now have the option to view the Classic Well 
Schematic. When StressCheck is installed, the default schematic view displays. To change to 
the Classic view, select Tools > Options and activate the Classic Schematic View checkbox. 
Deactivation of this checkbox will return the schematic display to the default setting.

• Internationalization. StressCheck is now designed to support regional settings in Windows.

• Well Explorer Virtual Folders Added to the Well Explorer Tree. These folders allow users 
to organize data items (such as Projects, Wells, Designs, etc.) in a customizable hierarchy that 
can be up to three levels deep.

• New Assemblies. There were added to the Associated Data Viewer with copy/paste 
functionality: Casing, Tubing. Not valid for Actual Designs.

• Catalogs. These were added for Well Completion components. Support for these catalogs 
was added to OpenWells, PROFILE, WELLPLAN, and Catalog Editor.

WELLPLAN

• Platform. WELLPLAN is an application on Engineer’s Desktop 5000.0.0. For this release, 
WELLPLAN is available on Windows Vista Enterprise.

• New Friction Calibration Torque Drag Chart. This new feature allows for graphical calibra-
tion of friction factors.

• New Plot. The pressure to break the gel strength at various times can be determined using 
the Pressure-ECD Chart (Pressure: Pump Rate Fixed).

• Back Pressure Available in Analysis. You can use the Pressure: Pump Rate Fixed Analy-
sis Mode and the Pressure: Pump Rate Range Analysis Mode.
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• Reverse Circulation. This procedure, which pumps cement and spacers directly down the 
annulus, can now be modeled.

• Well Explorer Virtual Folders Added to the Well Explorer Tree. These folders let you 
organize data items (such as Projects, Wells, Designs, etc.) in a customizable hierarchy that 
can be up to three levels deep.

• Integrated WITSML v. 1.2 Support. This feature allows creation of OpenWire 2003.0.8 
pipelines from the Well Explorer tree to load data into the EDM database directly from a remote 
WITSML server.

• OpenWire Pipelines. These can be created directly from the Well Explorer. You can launch 
the Real-Time View application directly from the Associated Data Viewer and use it to 
compare actual and planned log data.

• Catalogs. These were added for Well Completion components. Support for the catalogs was 
added to OpenWells, PROFILE, WELLPLAN, and Catalog Editor.

• New Assemblies. These were added to the Associated Data Viewer with copy/paste 
functionality: Casing, Tubing, and Drillstrings. Not valid for Actual Designs.

• Fixed WELLPLAN Problems. The following significant defects were fixed:

— Defect #743765: Java Exception warning when creating a WELLPLAN case from a 
StressCheck casing design.

— Defect #748119: Backreaming results not updating when changing friction factors when 
all loads were selected on the Mode Data dialog.

— Defect #750148: Cannot change the mud density units to specific gravity for an API- 
based custom unit set, or to ppg from an SI-based unit set.

— Defect #752276: The cuttings loading option does not affect the Hydraulics drag chart 
analysis results.

— Defect #752297: When using the Hydraulics Pump Rate Fixed analysis, the tool joint 
option does not affect the results displayed in the Hydraulics drag chart or the Annulus 
ECD plot.

3D Drill View KM

• Platforms. 3D Drill View KM is a DecisionSpace application. For Release 5000.0.0, 3D Drill 
View KM will be available on the official Release 5000.0.0 Linux and Windows XP platforms, 
and will access OpenWorks 5000.0.0 on Oracle 10g. 

• Create Knowledge Attachments in 3D View. To create a Knowledge Attachment in the 3D 
View, right-click on a wellbore and select Add EDM Knowledge Attachment, or Add DIMS 
Knowledge Attachment depending on the drilling database you are using. Note that you must 
have checked the Enable box on the corresponding KM EDM or KM DIMS tab. 

• Knowledge Attachment Symbols Stored in EDM Database. KM symbols are now stored in 
the EDM database. (Prior to R2003.19.1, the symbols were stored in files.) Any symbols 
stored in files will be uploaded into the EDM database the first time you open the database. 
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• 3DDV KM Runs on Linux. 3DDV KM now runs on Linux and can connect to either Oracle or 
SQL Server EDM databases. 

• Select All and Clear All Buttons. The buttons were added to the Choose Items dialog box 
to improve its usability. 

Collaborative Well Planning

• Software Family in the DecisionSpace Environment. It now includes AssetPlanner, 
TracPlanner, PrecisionTarget, and the new Field Scenario Planner applications.

• Platforms. For Release 5000.0.0, the Collaborative Well Planning applications will be avail-
able on the official Release 5000.0.0 Linux, Solaris, and Windows XP platforms and will 
access OpenWorks 5000.0.0 on Oracle 10g.

• Manual Targeting. Several enhancements were included to allow better use of geologic 
models and to provide more control when creating targets for both manual and automatic 
planning. 

• References to OpenWorks Saved in OpenWorks WellPlanning Projects. 
WellPlanning objects created from OpenWorks wells are saved with the OpenWorks Well-
Planning project. Therefore, OpenWorks will automatically load these wells when the Open-
Works well is opened. 

• Recommended Surface Location or Kickoff Depth Based on Hold Angle. The software 
can recommend a surface location or kickoff depth based on a specified hold angle. The sur-
face location or kickoff depth will be calculated using a hold angle as close as possible to the 
requested hold angle. 

• Sidetrack Plan Type Added to the AssetPlanner Advanced Mode. AssetPlanner can now 
create sidetracks from existing or planned wells. Sidetracks can be based on three plan 
types, including sidetrack, horizontal sidetrack, and S-shaped sidetrack. It is possible to 
restrict the creation of sidetracks to a certain well type such as shut-in, etc.

• Snap Penetration Points in Reference Targets. When working with TracPlanner, use 
Plans > Snap Reference Targets to move the reference target penetration point to the point 
where the wellbore intersects the target. (The default penetration point for the reference tar-
get is the center of the target.) 

• Casing and Liner Data. A Casing tab has been added to the Well Plan Properties dialog 
box. Casing and liner data available in OpenWorks is displayed (read-only) on this tab. When 
creating a new plan, data can be entered into this tab. This data is used when creating side-
tracks to ensure the minimum inside diameter criteria is met. 

• Improved Sidetrack Options. Existing sidetracks now have the same planning options as 
new sidetracks. This functionality includes investigating alternative millout depths within a 
specified distance from the current millout depth. You can specify a minimum inside diameter 
to determine if a sidetrack is possible at any depth by comparing this diameter to the casing 
and liner data. 

• New Setting. Set Back TVD - Use Plans > Apply SetBack to ensure the wellpath has the 
same inclination and azimuth from the last target to the specified (Set Back) TVD above the 
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second to last target as it does between these two targets. This functionality applies to sur-
face or platform plans using Optimum Align and consisting of at least two targets. 

• Plan Optimization Enhancement - Optimization. It now includes penetration points, kickoff 
depths, and millout points, as well as automatically testing for more efficient plans using refer-
ence targets. Anticollision and hazard avoidance will be considered if the AssetPlanner mod-
ule is licensed. 

• Table Editing. Several changes were made to improve table editing. Buttons were renamed 
for consistency, and cell contents are automatically overwritten when typing begins in the cell. 

• Editing of Well Types. It is now possible to change the type of a well (producer, injector, 
etc.). If the well is an OpenWorks well, the change is only within the context of the current 
Well Planning project and does not change the actual OpenWorks type. 

• Saving and Retrieving Plan Parameters. In AssetPlanner and ScenarioPlanner, plan set-
ups can now be saved and retrieved for later use. 

• Improved Completion Calculation. A parameter titled “Default Reservoir Penetration” has 
been added to the Costs tab in AssetPlanner. This field is used to determine where to begin 
completion costs. In the past, completion costs were based on the perforation length. For 
wells without a perforation length, a zero length completion interval resulted. 

• Editing Target, Plan, and Scenario Parameters. Any numeric column can now be edited 
and saved to the project. Columns can also be added or deleted. Note that this save applies 
only to the WellPlanning project and does not affect OpenWorks data or wbp files. 

• Importing Paths as TurnPoints. Turn points can now be derived from imported survey data.

• New Plan Type Parameters. Additional parameters were added to several plan types. 

• Field Scenario Planner. A new module titled Field Scenario Planner has been added. This 
module includes three modes: Scenario Setup, View Scenario Set, and Scenario Target Anal-
ysis. 

— The Scenario Setup mode facilitates the creation and editing of a set of development 
scenarios.

— The View Scenario Set mode is used to compare the scenarios created using the Sce-
nario Setup mode.

— The Scenario Target Analysis mode is used to compare scenarios on a target-by-target 
basis.

• Scenes. A new Scenes tab takes advantage of AssetView’s multi-scene, multi-view function-
ality. 

• EDM Import and EDM Export - EDM Import and EDM Export Options. These have been 
added to the File menu. Use these options to import or export data between Well Planning 
and an Oracle EDM database (version 2003.16.0 or later). 

• Surface Grids. You can now use surface grids when you are working with AssetPlanner. For 
example, a sea floor grid can be used to obtain water depth. Using the water depth from the 
grid, AssetPlanner can put platforms in a specified water depth. You could also use a topog-
raphy grid to place platforms or wells only where the surface is less than a certain inclination.
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• Site Slot Templates Setups. These can now be saved. The site setup that is saved can 
include multiple templates and/or individual wells. After the setup is saved, it can be used as 
a basis for other sites. 

OpenWire

• Platforms. For Release 5000.0.0, OpenWire is available on Windows Vista Enterprise Client 
(Vista Server is not supported), Windows XP Client, and Windows 2003 Server.

• Supported Versions. OpenWire will support WITSML version 1.3.1 as well as version 1.2.0 
for the standard objects.

• Integrated Workflow. OpenWire supports an integrated workflow with the EDM-based appli-
cations, allowing simplified creation of Pipelines from within the Engineering applications.

• Support for Reports Objects. OpenWire now supports the reports objects for simplifying the 
data entry into OpenWells when data is available in a digital format.

Wellbore Planner

• Platforms. Wellbore Planner is now available on the official Release 5000.0.0 Linux and 
Solaris platforms and will access OpenWorks 5000.0.0 on Oracle 10g.

• Wellbore Planner Fixed Problems:

— Defect #163061: Wellbore Planner does not populate the Original location information for 
a well when created from a well plan. 

— Defect #722088: Recalculation of wellpath (position log) causes duplicate line in poslog 
table. As a result, the wellpath will not display in OpenVision, and an error message will 
display indicating the wellpath cannot be loaded. 

— Defect #177358: When a WBP plan is saved as an OpenWorks well, the time/depth table 
created is not set to be the preferred time/depth table. 

— Defect #702580: Import of ASCII file containing survey data (knee points) is limited to 197 
data points.

— Defect #719633: Wellbore Planner freezes when importing a COMPASS ASCII file with 
more than 196 lines.

— Defect #306010: COMPASS file fails to import if comment line exceeds 78 characters.

— Defect #732053: Wellbore planner not saving platform wells correctly.

— Defect #732054: Wellbore planner not saving turn point correctly for extend sections.

— Defect #156683: Parent well not retained after saving plan and reopening second time.

— Defect #118667: Entering large character strings into the Uncertainty > Survey Tools > 
Edit Name and Description fields produces an error when the Add/Update icon is 
selected. 
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Geological and Geophysical Technologies

These applications use the new Seismic Data Management functionality in OpenWorks. For more 
information, see Seismic Data Management in OpenWorks on page 49. 

GeoProbe + ezModel

• OpenWorks 5000.0.0. Port. For Release 5000.0.0, the OpenWorks data model has been 
streamlined to reduce data duplication. Now, you can view subsets—called interpretation 
projects—of a project database; the data in the interpretation project is shared dynamically by 
reference. In addition, seismic and horizon data can have a processing history attached to 
them. GeoProbe's data structure has been modified to accommodate these changes.

• Multi-Survey States. GeoProbe's data structure has been re-configured to take into account 
individual surveys located within a larger project. Now, Multi-Survey instances in GeoProbe 
can be saved into a single state file.

• Data on Demand. In addition to loading volumes into shared memory, you can now load 
volumes directly from disk into GeoProbe using Data on Demand. When you use this new 
*.d3d disk caching format, loaded volumes are no longer limited to the amount of memory on 
a given system. Therefore, you can load large data volumes without compromising 
visualization speed.

• Seismic 2D Data Direct from SeisWorks. Seismic 2D Data can now be loaded into 
GeoProbe directly from SeisWorks. swFault segments are easily interpreted on these 2D lines 
and saved back to OpenWorks. In addition, horizons are picked using ManuTrack and can be 
interpolated on demand using the SeisWorks gridding library. To further improve the 
interpretation workflow with PowerView, 2D line locations are now shared via PD messaging.

• Direct Data Access. Data loading has been reconfigured to remove the requirement for an 
external DataServer. This change has greatly optimized the loading of swFaults, Horizons, 
and 2D Data; they are now loading 10 to 20 times faster than in previous versions. 

• Culture Object. A new Culture object lets you load and manipulate ZGF layers. These culture 
files can be clipped to volume extents, and individual layers in single files can be enabled and 
disabled from view.

• Blending Volumes into a Single Display. Advances in graphics card development give 
GeoProbe the ability to “blend” two volumes into a single display. For example, by using a 
seismic amplitude volume as a base volume, you can now overlay a velocity volume on the 
seismic. The second volume still has a color map of its own, and transparency values on this 
color map determine the saturation of the volume on the display. In addition, when you use the 
new dynamic waveform display, wiggle traces can be displayed on the faces of a Probe. 
Parameters that determine the size, spacing, and overall appearance of these traces can be 
set.

• Horizon Curvature. A variety of Horizon Curvature attributes are now available for display on 
the selected horizon. These attributes aid in the prediction of fractures and faults. 
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• ezTracker Fault Blocking Option. ezTracker can now use a “fault blocking” volume created 
from within PowerView. Using this volume in conjunction with the tracking algorithm will quickly 
create horizons that are constrained by the faults in the survey. You will not have to interpret 
the fault network first.

• ezModel Additions. More options have been added for working with horizons in the structural 
model. Horizons can now be sealed against one another; based on the order they occur in 
time/depth. In addition, specifying each horizon interval's minimum thickness allows for a 
wider variety of stratigraphic models.

• Well Section. This new feature creates a vertical plane of seismic data through the path of the 
selected wellbore. These planes display the data around the wellbore as well as any enabled 
horizon and fault interpretations that intersect the plane. 

• Usability Improvements. All objects in the GeoProbe viewer are now selectable and can be 
disabled using Mouse Button 2. The object's full menu can be accessed using MB3. Tabs for 
swFaults and ezFaults have been added to the User Preferences dialog box. They let you 
configure display and interpretation settings that will persist in the GeoProbe session.

PetroWorks

• OpenWorks Project Optimization. The 5000.0.0 release supports OpenWorks Project Opti-
mization, which enhances the data model to support new workflows, reduce cycle time, and 
fully migrate all seismic project data into the OpenWorks project framework. Integration is 
built into the Data Model, not the application. Highlights include enhancements to the Open-
Works Data Model to enable the storage and management of seismic and associated data, 
major enhancements to the Interpretation ID Model, the addition of metadata and Processing 
History Model, redesigned Data Managers, and OpenWorks and Engineer's Data Model 
(EDM) rationalization.

• Log Modeling Package. The PetroWorks Log Modeling Package now includes log 
normalization and the ability to create pseudo logs.

PowerCalculator

• New Data Types. They include the following:

— Support for 2D horizons for a variety of math computations.

— Support for OpenWorks grids for complex math computations. In general, the grids can 
be used interchangeably with 3D horizons, making for some very powerful, yet simple, 
workflows.

— OpenWorks polygons, which can be used in some new functions that support processing 
of the grid information.

• New Calculations and Modes. They include the following:

— Calculations can be executed in “Multiple” mode, which enables operations between 3D 
horizons in different seismic projects.
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— The QuickView now supports the display of multiple data simultaneously. This enhance-
ment lets you quickly evaluate if and how disparate data types overlap within regions.

— A robust spatial interpolation algorithm is added for 3D horizon data. By being a part of 
the PowerCalculator processing flow engine, this algorithm enables a single button click 
to fill, smooth, and clip within the interpreter’s favorite set of algorithms.

— The Blank function applies a specific polygon set, containing inclusive and/or exclusive 
polygons, to a 2D or 3D horizon, or to an OpenWorks grid.

PowerView

• Interpretation Notes. This enhancement provides advanced tools for interpreters to add x, y, 
z location markers containing text, images, and links to documents. Interpretation notes can 
also be attached to other data objects. This information is captured as a permanent part of the 
OpenWorks interpretation data record. Here are some of the many ways Interpretation Notes 
can be used:

— As captured “To-Do” lists for completing the interpretation.

— As “Why” notes that document the interpreter’s reasoning at a key decision point.

— As “Knowledge-Capture” notes that provide quick and easy access to published articles 
or previous interpretations. 

These features combine for a significantly enhanced interpretation experience and provide 
opportunities for increased productivity and improved quality.

• Interpretation Sets. Effective data management is one of the more challenging tasks for 
today’s interpreter. A multitude of different data types as well as different versions of data can 
collectively contribute to a specific decision. This combination of data can vary from the set of 
input horizons, picks, velocity model, and fault polygons that contribute to a particular surface 
grid construction to the appropriate set of horizons, faults, velocity model, and seismic that 
represent the properly versioned 85 percent confidence/risk prospect interpretation. 
Interpretation Sets allow the interpreter to create logical groupings of projects information, 
organized and named in hierarchical folders. These groupings, or mini-projects, can be easily 
and quickly recalled for scenario/version/risk-confidence workflows and operations.

• GeoProbe 2D Line Probes. With support for 2D seismic interpretation in GeoProbe, the tight 
GeoProbe > PowerView integration which syncs up a GeoProbe probe face to a PowerView 
Section is extended to include 2D seismic data.

SeisWorks 

• OpenWorks Project Optimization. The 5000.0.0 release supports OpenWorks Project Opti-
mization, which enhances the data model to support new workflows, reduce cycle time, and 
fully migrate all seismic project data into the OpenWorks project framework. Integration is 
built into the Data Model, not the application. Highlights include enhancements to the Open-
Works Data Model to enable the storage and management of seismic and associated data, 
major enhancements to the Interpretation ID Model, the addition of metadata and Processing 
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History Model, redesigned Data Managers, and OpenWorks and Engineer's Data Model 
(EDM) rationalization.

• Horizons and 2D Lines. There are no more limits on the number you can use.

• Processing History. You will be able to access this information for horizons and seismic. The 
enhancement eliminates the need for elaborate naming conventions. 

• Identification of Horizons. They are identified by name, version, interpreter, and attribute.

• Additional Meta Data. This information is available for horizons, seismic, and faults.

StratWorks

• OpenWorks Project Optimization. The 5000.0.0 release supports OpenWorks Project Opti-
mization, which enhances the data model to support new workflows, reduce cycle time, and 
fully migrate all seismic project data into the OpenWorks project framework. Integration is 
built into the Data Model, not the application. Highlights include enhancements to the Open-
Works Data Model to enable the storage and management of seismic and associated data; 
major enhancements to the Interpretation ID Model; the addition of metadata and the Pro-
cessing History Model; redesigned Data Managers; and OpenWorks and Engineer's Data 
Model (EDM) rationalization.

• Surface Mapping Enhancements. StratWorks was enhanced to include dip and azimuth 
calculations with pick data and to grid dip data to use in surface mapping. The purpose of this 
enhancement is to calculate dip information to include with pick data in the PICK table. Dip 
meter table data is averaged to calculate values.

SynTool

• OpenWorks Project Optimization. The 5000.0.0 release supports OpenWorks Project 
Optimization, which enhances the data model to support new workflows, reduce cycle time, 
and fully migrate all seismic project data into the OpenWorks project framework. Integration is 
built into the Data Model, not the application. Highlights include enhancements to the 
OpenWorks Data Model to enable the storage and management of seismic and associated 
data; major enhancements to the Interpretation ID Model; the addition of the metadata and 
Processing History Model; redesigned Data Managers; and OpenWorks and Engineer's Data 
Model (EDM) rationalization.

• Tighter integration with OpenWorks. This release dramatically improves the way that 
seismic and associated data are managed and stored. SeisWorks projects have been 
eliminated, and OpenWorks is extended to manage seismic and other project data. Seismic 
data and 3D horizon data are stored externally but catalogued and managed through 
OpenWorks. 2D horizon data is stored within OpenWorks.

• Datum Behavior. Modifications in datum behavior make it work in conjunction with the 
automatic datuming of SeisWorks seismic data provided by the OpenWorks seismic data 
optimization in Release 5000.0.0. The changes mean there is both a datum and correctional 
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velocity tied to the Interpretation Project (IP) and a datum tied to the 3D survey and the 2D line 
seismic data. They work together to provide dynamic datuming of the seismic data to the 
datum of the IP. Because the datuming or start time modification of the seismic data is being 
performed on the OpenWorks side and is external to the SynTool application, SynTool now 
includes some minor changes concerning the initial Time datum setting and the updating of 
the datum when SeisWorks seismic data is selected for display.

In previous releases, the initial SynTool Time datum would be set by selecting a SeisWorks 
project. You could then modify the datum value before completing the initialization of the 
SynTool session. For Release 5000.0.0, the initial time datum will be set to the datum of the 
Interpretation Project that you are using. This change is required to maintain integration with 
SeisWorks, which also uses the IP datum when initializing. Because the SeisWorks seismic 
data is tied to this datum, you will not be able to modify the datum during initialization. You can, 
however, modify the datum setting once the session has initialized by using Datum Info. 
Another change revolves around the selection of SeisWorks seismic for display. In the 
previous release of SynTool, if the selected seismic data was from a different SeisWorks 
project at a different datum from the SynTool, the SynTool session would change the current 
datum to this datum and use its internal method for calculating the correctional velocity for 
setting the datum shifted time scale. In Release 5000.0.0, because the SeisWorks seismic 
data is being dynamically datumed to the Interpretation project datum using the correctional 
velocity in the IP, this option is no longer required and has been removed. To maintain 
consistency with SeisWorks, use or modify the settings in the Interpretation Project if the initial 
datum needs to be set to a different value. If the datum of the seismic data needs to be 
changed, do so in the 3D Survey or 2D Line setting in Seismic Data Manager, before you 
launch SynTool. 

Once the SynTool session has initialized, you can make datum modifications by selecting 
Datum Info from within the SynTool application. Likewise, if you are looking for the same 
behavior as in earlier releases, set the IP datum to 0 and the 3D Survey or 2D Line datum 
to 0. Then use Datum Info and SynTool’s internal datuming calculations to provide the datum 
modifications for the SynTool session.

• SynTool Fixed Problems:

— Defect #760430: When saving a synthetic to SEG-Y you can now enter up to 200 charac-
ters for the file name. This has been increased from 54. 

— Defect #631615: Extraction process hangs when you extract Wellbore Seismic for a hori-
zontal well.

— Defect #739567: It is taking too long to access a seismic volume list or SeisWell. Need a 
patch to improve performance. (Fixed with the OpenWorks Seismic data management.)

TDQ

• OpenWorks Project Optimization. The 5000.0.0 release supports OpenWorks Project 
Optimization, which enhances the data model to support new workflows, reduce cycle time, 
and fully migrate all seismic project data into the OpenWorks project framework. Integration is 
built into the Data Model, not the application. Highlights include enhancements to the 
OpenWorks Data Model to enable the storage and management of seismic and associated 
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data; major enhancements to the Interpretation ID Model; the addition of the metadata and the 
Processing History Model; redesigned Data Managers; and OpenWorks and Engineer's Data 
Model (EDM) rationalization.

• Tighter integration with OpenWorks. This release dramatically improves the way that 
seismic and associated data are managed and stored. SeisWorks projects have been 
eliminated, and OpenWorks is extended to manage seismic and other project data. Seismic 
data and 3D horizon data are stored externally but catalogued and managed through 
OpenWorks. 2D horizon data is stored within OpenWorks.

• Sharing of Models. TDQ models are stored in the master project and not the Interpretation 
Project, so the model can be shared. 

• Simplified and Optimized Project Administration. This change eliminates the need for 
seismic projects in SeisWorks. Master and working projects have been integrated into the new 
OpenWorks structure.

• Identification of Horizons. They are identified by name, version, interpreter, and attribute.

• TDQ Fixed Problems:

— Defect #717279: Setting Sample Interval less than one defaults back to one upon conver-
sion.

— Defect #730538: Does not convert OpenWorks grids properly when depth units differ 
from project units.

— Defect #632665: Does not like sub-millisecond sample intervals.

— Defect #702403: Creates line thickness value of -98765 in SFDM. 

Well Seismic Fusion

• Prestack Seismic Data Management via OpenWorks. To make prestack seismic data 
accessible to any interpreter at any time, Well Seismic Fusion now catalogs the prestack data 
in OpenWorks. The catalog contains basic survey geometry, parent/child relationships, and a 
pointer to where the prestack actually exists on disk.

• Offset Synthetics and VSP Data Managed via OpenWorks. Well Seismic Fusion now 
stores 2D offset-synthetics and offset-VSP data directly in OpenWorks. This change allows 
any interpreter to access these data types at any time. 

• Working with Multiple 2D Lines; 3D Surveys; and Interpretation Projects. Well Seismic 
Fusion can now manage any number of 2D lines or 3D surveys within any number of 
interpretation projects in a single session.

• “Basic” and “Full” Licensing of Well Seismic Fusion. A less-expensive “Basic” License is 
now available for users who just want to view and crossplot prestack data. The “Full License” 
allows for much more in-depth AVO analysis on all data types. 
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Z-MAP Plus

• OpenWorks Project Optimization. The 5000.0.0 release supports OpenWorks Project Opti-
mization, which enhances the data model to support new workflows, reduce cycle time, and 
fully migrate all seismic project data into the OpenWorks project framework. Integration is 
built into the Data Model, not the application. Highlights include enhancements to the Open-
Works Data Model to enable the storage and management of seismic and associated data; 
major enhancements to the Interpretation ID Model; the addition of metadata and Processing 
History Model; redesigned Data Managers; and OpenWorks and Engineer's Data Model 
(EDM) rationalization.

• File Manager Enhancements. The time of file creation is now displayed as well as the date. 
This allows for sorting of files by date and time. In addition, the number of ZGFs that can be 
listed has been increased from 1000 to 12000. The number of MFD and OpenWorks files 
(such as grids, pointsets, etc.) has increased from 1000 to 9999.

• Text Posting Enhancement. You can now specify that you want to clip text files posted on 
maps at the map border.

• Contour Enhancements. Z-MAP Plus has enhanced the Contouring GUI to include distance 
between labels; and bold, hachure, and dash contour settings. (60657)


